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Manual VIPA System 200V About this manual

About this manual

Overview

This manual describes the System 200V CPU 214-1BC06 and CPU 21x-
1BAO06 from VIPA. Here you may find every information for commissioning
and operation.

Chapter 1: Basics and Assembly

The focus of this chapter is on the introduction of the VIPA System 200V.
Here you will find the information required to assemble and wire a
controller system consisting of System 200V components.

Besides the dimensions the general technical data of System 200V will be
found.

Chapter 2: Hardware description

Here the hardware components of the CPU are described. The technical
data are at the end of the chapter.

Chapter 3: Deployment CPU 21x-1Bx06

This chapter describes the deployment of the CPU in the System 200V.
The description refers directly to the CPU and to the deployment in
connection with peripheral modules, mounted on a profile rail together with
the CPU at the backplane bus.

Chapter 4: Configuration with TIA Portal

In this chapter the project engineering of the VIPA CPU in the Siemens TIA
Portal is shown. The chapter only describes the basic usage of the
Siemens TIA Portal together with a VIPA CPU .

More detailed information about the Siemens TIA Portal is to be found in
the according online manual respectively documentation.

HBO7E - CPU - RE_21x-1Bx06 - Rev. 13/20 1



About this manual

Manual VIPA System 200V

Objective and
contents

Target audience

Structure of the
manual

This manual describes the System 200V CPU 214-1BC06 and CPU 21x-
1BA06 from VIPA. It contains a description of the construction, project
implementation and usage.

This manual is part of the documentation package with order number
HB97E_CPU and relevant for:

Product Order number as of state:
CPU-HW CPU-FW
CPU 21x VIPA CPU 21x-1Bx06 |01 V 419

The manual is targeted at users who have a background in automation
technology.

The manual consists of chapters. Every chapter provides a self-contained
description of a specific topic.

Guide to the The following guides are available in the manual:
document  an overall table of contents at the beginning of the manual
» an overview of the topics for every chapter
Availability The manual is available in:
» printed form, on paper
* in electronic form as PDF-file (Adobe Acrobat Reader)
Icons Important passages in the text are highlighted by following icons and
Headings headings:
Danger!
Immediate or likely danger.
Personal injury is possible.
Attention!
Damages to property is likely if these warnings are not heeded.
Note!
Supplementary information and useful tips.
2 HB97E - CPU - RE_21x-1Bx06 - Rev. 13/20




Manual VIPA System 200V Safety information

Safety information

Applications The CPU 21x is constructed and produced for:

conforming with .
specifications .

all VIPA System 200V components
communication and process control
general control and automation applications
industrial applications

operation within the environmental conditions specified in the technical
data

installation into a cubicle

Danger!
This device is not certified for applications in

in explosive environments (EX-zone)

Documentation The manual must be available to all personnel in the

project design department
installation department
commissioning

operation

The following conditions must be met before using or commissioning
the components described in this manual:

Hardware modifications to the process control system should only be
carried out when the system has been disconnected from power!

Installation and hardware modification only by properly trained
personnel.

The national rules and regulations of the respective country must be
satisfied (installation, safety, EMC ...)

Disposal National rules and regulations apply to the disposal of the unit!

HBO7E - CPU - RE_21x-1Bx06 - Rev. 13/20 3
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Manual VIPA System 200V Chapter 1 Basics and Assembly

Chapter 1

Overview

Contents

Basics and Assembly

The focus of this chapter is on the introduction of the VIPA System 200V.
Here you will find the information required to assemble and wire a controller
system consisting of System 200V components.

Besides the dimensions the general technical data of System 200V will be
found.

Topic Page
Chapter 1  Basics and Assembly .........cccccmiiiiiiiiieinencceeeeee 11
Safety Information for USers...........oooovmiiiiiiiiiiicce e, 1-2
System CONCEPLION ..o 1-3
D10 1= g T 1= 1-5
INStAllAtioON ... 1-7
Demounting and module exchange..............ccocoiiiiiiiiiiiiiieeeeeeee 1-11
WG e ———— 1-12
Installation gUIdelineS ...........ooeiiiiiiiiiii e 1-14
General data ... 1-17
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Chapter 1 Basics and Assembly Manual VIPA System 200V

Safety Information for Users

Handling of
electrostatic
sensitive modules

Shipping of
electrostatic
sensitive modules

Measurements and
alterations on
electrostatic
sensitive modules

VIPA modules make use of highly integrated components in MOS-
Technology. These components are extremely sensitive to over-voltages
that can occur during electrostatic discharges.

The following symbol is attached to modules that can be destroyed by
electrostatic discharges.

The Symbol is located on the module, the module rack or on packing
material and it indicates the presence of electrostatic sensitive equipment.
It is possible that electrostatic sensitive equipment is destroyed by energies
and voltages that are far less than the human threshold of perception.
These voltages can occur where persons do not discharge themselves
before handling electrostatic sensitive modules and they can damage
components thereby, causing the module to become inoperable or
unusable.

Modules that have been damaged by electrostatic discharges can fail after
a temperature change, mechanical shock or changes in the electrical load.

Only the consequent implementation of protection devices and meticulous
attention to the applicable rules and regulations for handling the respective
equipment can prevent failures of electrostatic sensitive modules.

Modules must be shipped in the original packing material.

When you are conducting measurements on electrostatic sensitive modules
you should take the following precautions:

» Floating instruments must be discharged before use.
* Instruments must be grounded.

Modifying electrostatic sensitive modules you should only use soldering
irons with grounded tips.

Attention!

Personnel and instruments should be grounded when working on
electrostatic sensitive modules.

1-2
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Manual VIPA System 200V Chapter 1 Basics and Assembly

System conception

Overview The System 200V is a modular automation system for assembly on a
35mm profile rail. By means of the peripheral modules with 4, 8 and 16
channels this system may properly be adapted matching to your
automation tasks.
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Components The System 200V consists of the following components:
» Head modules like CPU and bus coupler
» Periphery modules like I/0O, function und communication modules
» Power supplies
» Extension modules

Head modules With a head module CPU respectively bus
interface and DC 24V power supply are
cPu2ia] 4 WZS0P | 4 integrated to one casing.
Zﬁ ool|(i Via the integrated power supply the CPU
o) o respectively bus interface is power
"o MCE supplied as well as the electronic of the
:;gz P g : connected periphery modules.
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Periphery modules The modules are direct installed on a

35mm profile rail and connected to the
head module by a bus connector, which
was mounted on the profile rail before.

Most of the periphery modules are
equipped with a 10pin respectively 18pin
connector. This connector provides the
electrical interface for the signaling and
supplies lines of the modules.
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Chapter 1 Basics and Assembly Manual VIPA System 200V

Power supplies With the System 200V the DC 24V power
supply can take place either externally or
via a particularly for this developed power

om| | supply.
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s[O 1k The power supply may be mounted on the
e profile rail together with the System 200V
- modules. It has no connector to the back-
= . plane bus.
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VIPA 207-1BA00
Expansion The expansion modules are complemen-
modules tary modules providing 2- or 3wire con-
W | 4 nection facilities.
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Structure/ Profile rail 35mm

dimensions

Dimensions of the basic enclosure:
1tier width: (HXWxD) in mm: 76x25.4x74 in inches: 3x1x3
2tier width: (HXWxD) in mm: 76x50.8x74 in inches: 3x2x3

Installation Please note that you can only install header modules, like the CPU, the PC
and couplers at slot 1 or 1 and 2 (for double width modules).

[1]1 |Head module
(double width)

[2] |Head module
(single width)

[3] |Periphery module

[4] | Guide rails

Note

A maximum of 32 modules can
be connected at the back plane
bus. Take attention that here the
maximum sum current of 3.5A
is not exceeded.

Please install modules with a
high current consumption direct-
ly beside the header module.
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Manual VIPA System 200V Chapter 1 Basics and Assembly

Dimensions

Dimensions 1tier width (HXWxD) in mm: 76 x 25.4 x 74
Basic enclosure 2tier width (HXWxD) in mm: 76 x 50.8 x 74

Installation
dimensions

“—60mm ————— P 80mm —————— ¥

AMMNTHH iy

Installed and wired
dimensions

In- / Output PR .

modules

*«~—— 74mm ——

i
NN
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Function modules/ 89 mm
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Manual VIPA System 200V Chapter 1 Basics and Assembly

Installation

General

Profile rail

Bus connector

The modules are each installed on a 35mm profile rail and connected via a
bus connector. Before installing the module the bus connector is to be
placed on the profile rail before.

For installation the following 35mm profile rails may be used:

el =T
i L
(;27mm*ﬁ (;Zhnm*ﬁ
Order number Label Description
290-1AF00 35mm profile rail Length 2000mm, height 15mm
290-1AF30 35mm profile rail Length 530mm, height 15mm

System 200V modules communicate via a backplane bus connector. The
backplane bus connector is isolated and available from VIPA in of 1-, 2-, 4-
or 8tier width.

The following figure shows a 1tier connector and a 4tier connector bus:

The bus connector is to be placed on the profile rail until it clips in its place
and the bus connections look out from the profile rail.

Order number Label Description
290-0AA10 Bus connector 1tier
290-0AA20 Bus connector 2tier
290-0AA40 Bus connector 4tier
290-0AA80 Bus connector 8tier

HBO7E - CPU - RE_21x-1Bx06 - Rev. 13/20 1-7




Chapter 1 Basics and Assembly Manual VIPA System 200V

Installation on a The following figure shows the installation of a 4tier width bus connector in
profile rail a profile rail and the slots for the modules.

The different slots are defined by guide rails.

[11 Header module
(double width)

[2] Header module
(single width)

[3] Peripheral module

[4] Guide rails

000000000
0000”0000
000D00D00

D
0000&d0DO00
000DOooDao
0000&A0D00
000D00DOdO0

i b

b b i Ak

o i b L

. 7= IER | HE I
Bl &5 | &5 | == | =5

Assembly regarding
the current
consumption

Use bus connectors as long as possible.

e Sort the modules with a high current consumption right beside the
header module. In the service area of www.vipa.com a list of current
consumption of every System 200V module can be found.
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Manual VIPA System 200V Chapter 1 Basics and Assembly

Assembly
possibilities
hoizontal assembly vertical Please regard the allowed environmental temperatures:
E = blcE bGE BlGE assembly horizontal assembly: from 0 to 60°C
% 7 - vertical assembly: from 0 to 40°C
\‘l J J JEssssssy| o lying assembly: from 0 to 40°C
oo s I_;r I_:r [mimImImINImIn NI nin]

----------

lying assembly === The horizontal assembly always starts at the left side with
SRR 4 header module, then you install the peripheral modules

S S s S beside to the right.
You may install up to 32 peripheral modules.

fobktkol

161

Please follow these rules during the assembly!

e Turn off the power supply before you install or remove
any modules!

« Make sure that a clearance of at least 60mm exists
above and 80mm below the middle of the profile rail.

AN\

60 mm

AN

» Every row must be completed from left to right and it
has to start with a header module.

[11 Header module (double width)
[2] Header module (single width)
[3] Peripheral modules

[4] Guide rails

* Modules are to be installed side by side. Gaps are not
permitted between the modules since this would
interrupt the backplane bus.

* A module is only installed properly and connected
electrically when it has clicked into place with an
audible click.

» Slots after the last module may remain unoccupied.

Note!

A maximum of 32 modules can be connected at the back plane bus. Take
attention that here the maximum sum current of 3.5A is not exceeded.

HBO7E - CPU - RE_21x-1Bx06 - Rev. 13/20 1-9
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Assembly
procedure
-
- ﬂ .
Z,
%
@»n
2,
7
|
%

Install the profile rail. Make sure that a clearance of at least 60mm
exists above and 80mm below the middle of the profile rail.

Press the bus connector into the profile rail until it clips securely into
place and the bus-connectors look out from the profile rail. This
provides the basis for the installation of your modules.

Start at the outer left location with the installation of your header
module and install the peripheral modules to the right of this.

[11 Header module
(double width)

[2] Header module
(single width)

[3] Peripheral module

[4] Guide rails

Insert the module that you are installing into the profile rail at an angle
of 45 degrees from the top and rotate the module into place until it
clicks into the profile rail with an audible click. The proper connection
to the backplane bus can only be guaranteed when the module has
properly clicked into place.

Attention!

Power must be turned off before modules are
installed or removed!

HB97E - CPU - RE_21x-1Bx06 - Rev. 13/20
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Demounting and module exchange

« Remove if exists the wiring to the module, by pressing both
locking lever on the connector and pulling the connector.

-

7 e The casing of the module has a spring loaded clip at the
bottom by which the module can be removed.

2

» The clip is unlocked by pressing the screwdriver in an upward
direction.

» Withdraw the module with a slight rotation to the top.

Attention!

Power must be turned off before modules are installed or
removed!

Please regard that the backplane bus is interrupted at the point
where the module was removed!

HBO7E - CPU - RE_21x-1Bx06 - Rev. 13/20 1-11
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Wiring

Overview

Most peripheral modules are equipped with a 10pole or a 18pole connector.
This connector provides the electrical interface for the signaling and supply
lines of the modules.

The modules carry spring-clip connectors for interconnections and wiring.

The spring-clip connector technology simplifies the wiring requirements for
signaling and power cables.

In contrast to screw terminal connections, spring-clip wiring is vibration
proof. The assignment of the terminals is contained in the description of the
respective modules.

You may connect conductors with a diameter from 0.08mm? up to 2.5mm?
(max. 1.5mm? for 18pole connectors).

The following figure shows a module with a 10pole connector.

[11 Locking lever

[2] Pin no. at the module
[3] Pin no. at the connector
° N [4] Wiring port

: [5] Opening for screwdriver
/

]

|

10l
20l
X |
so W
50l
X |
70l
so |
90l

e W
:JJ

1
2@

2 3@
/]

345

S © ® N O oA W N o

—

Note!
The spring-clip is destroyed if you push the screwdriver into the wire port!

Make sure that you only insert the screwdriver into the square hole of the
connector!

HB97E - CPU - RE_21x-1Bx06 - Rev. 13/20
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Wiring procedure

v ‘ ¢ |[nstall the connector on the module until it locks with an audible click.
For this purpose you press the two clips together as shown.

The connector is now in a permanent position and can easily be wired.

=7 /

The following section shows the wiring procedure from top view.

¢ Insert a screwdriver at an angel into the square opening as shown.

¢ Press and hold the screwdriver in the opposite direction to open the
contact spring.

« Insert the stripped end of the wire into the round opening. You can use
wires with a diameter of 0.08mm? to 2.5mm?
(1.5mm? for 18pole connectors).

LfJ

« By removing the screwdriver the wire is connected safely with the plug
I connector via a spring.

Note!

Wire the power supply connections first followed by the signal cables
(inputs and outputs).

HBO7E - CPU - RE_21x-1Bx06 - Rev. 13/20 1-13
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Installation guidelines

General

What means EMC?

Possible
interference
causes

The installation guidelines contain information about the interference free
deployment of System 200V systems. There is the description of the ways,
interference may occur in your control, how you can make sure the
electromagnetic digestibility (EMC), and how you manage the isolation.

Electromagnetic digestibility (EMC) means the ability of an electrical device,
to function error free in an electromagnetic environment without being
interferenced res. without interferencing the environment.

All System 200V components are developed for the deployment in hard
industrial environments and fulfill high demands on the EMC. Nevertheless
you should project an EMC planning before installing the components and
take conceivable interference causes into account.

Electromagnetic interferences may interfere your control via different ways:

Electromagnetic fields (RF coupling)
Magnetic fields with power frequency
I/O signal conductors

Bus system

Current supply

Protected earth conductor

Depending on the spreading medium (lead bound or lead free) and the
distance to the interference cause, interferences to your control occur by
means of different coupling mechanisms.

One differs:

galvanic coupling
capacitive coupling
inductive coupling
radiant coupling

HB97E - CPU - RE_21x-1Bx06 - Rev. 13/20



Manual VIPA System 200V Chapter 1 Basics and Assembly

Basic rules for
EMC

In the most times it is enough to take care of some elementary rules to
guarantee the EMC. Please regard the following basic rules when installing
your PLC.

Take care of a correct area-wide grounding of the inactive metal parts
when installing your components.

- Install a central connection between the ground and the protected
earth conductor system.

- Connect all inactive metal extensive and impedance-low.

- Please try not to use aluminum parts. Aluminum is easily oxidizing
and is therefore less suitable for grounding.

When cabling, take care of the correct line routing.

- Organize your cabling in line groups (high voltage, current supply,
signal and data lines).

- Always lay your high voltage lines and signal res. data lines in
separate channels or bundles.

- Route the signal and data lines as near as possible beside ground
areas (e.g. suspension bars, metal rails, tin cabinet).

Proof the correct fixing of the lead isolation.
Data lines must be laid isolated (for details see below).

Analog lines must be laid isolated. When transmitting signals with
small amplitudes the one sided laying of the isolation may be
favorable.

Lay the line isolation extensively on an isolation/protected earth con-
ductor rail directly after the cabinet entry and fix the isolation with
cable clamps.

- Make sure that the isolation/protected earth conductor rail is
connected impedance-low with the cabinet.

- Use metallic or metalized plug cases for isolated data lines.
In special use cases you should appoint special EMC actions.

- Wire all inductivities with erase links, which are not addressed by the
System SLIO modules.

- For lightening cabinets you should avoid luminescent lamps.

Create a homogeneous reference potential and ground all electrical
operating supplies when possible.

- Please take care for the targeted employment of the grounding
actions. The grounding of the PLC is a protection and functionality
activity.

- Connect installation parts and cabinets with the System SLIO in star
topology with the isolation/protected earth conductor system. So you
avoid ground loops.

- If potential differences between installation parts and cabinets occur,
lay sufficiently dimensioned potential compensation lines.

HBO7E - CPU - RE_21x-1Bx06 - Rev. 13/20 1-15
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Isolation of
conductors

Electrical, magnetically and electromagnetic interference fields are
weakened by means of an isolation, one talks of absorption.

Via the isolation rail, that is connected conductive with the rack,
interference currents are shunt via cable isolation to the ground. Hereby
you have to make sure, that the connection to the protected earth conduc-
tor is impedance-low, because otherwise the interference currents may
appear as interference cause.

When isolating cables you have to regard the following:
» If possible, use only cables with isolation tangle.
» The hiding power of the isolation should be higher than 80%.

* Normally you should always lay the isolation of cables on both sides.
Only by means of the both-sided connection of the isolation you achieve
high quality interference suppression in the higher frequency area.

Only as exception you may also lay the isolation one-sided. Then you
only achieve the absorption of the lower frequencies. A one-sided
isolation connection may be convenient, if:

- the conduction of a potential compensating line is not possible
- analog signals (some mV res. yA) are transferred
- foil isolations (static isolations) are used.

 With data lines always use metallic or metalized plugs for serial
couplings. Fix the isolation of the data line at the plug rack. Do not lay
the isolation on the PIN 1 of the plug bar!

* At stationary operation it is convenient to strip the insulated cable
interruption free and lay it on the isolation/protected earth conductor line.

» To fix the isolation tangles use cable clamps out of metal. The clamps
must clasp the isolation extensively and have well contact.

» Lay the isolation on an isolation rail directly after the entry of the cable in
the cabinet. Lead the isolation further on to the System 200V module
and don't lay it on there again!

Please regard at installation!

At potential differences between the grounding points, there may be a
compensation current via the isolation connected at both sides.

Remedy: Potential compensation line.
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General data

Structure/ * Profile rail 35mm
dimensions « Peripheral modules with recessed labelling
» Dimensions of the basic enclosure:
1tier width: (HXWxD) in mm: 76x25.4x74 in inches: 3x1x3
2tier width: (HxWxD) in mm: 76x50.8x74 in inches: 3x2x3

Reliability * Wiring by means of spring pressure connections (CageClamps) at the
front-facing connector, core cross-section 0.08 ... 2.5mm? or 1.5 mm?

(18pole plug)
» Complete isolation of the wiring when modules are exchanged
» Every module is isolated from the backplane bus
» ESD/Burst acc. IEC 61000-4-2 / IEC 61000-4-4 (to level 3)
» Shock resistance acc. IEC 60068-2-6 / IEC 60068-2-27 (1G/12G)
» Class of protection IP20

Environmental » Operating temperature: 0 ... +60°C

conditions « Storage temperature: -25 ... +70°C
* Relative humidity: 5 ... 95% without condensation
» Ventilation by means of a fan is not required

HBO7E - CPU - RE_21x-1Bx06 - Rev. 13/20 1-17
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Chapter 2 Hardware description

Overview Here the hardware components of the CPU are described. The technical
data are at the end of the chapter.
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Chapter 2 Hardware description

Manual VIPA System 200V

Properties

CPU 21x-1Bx06

Instruction set compatible with Siemens STEP"7

» Configuration by means of the Siemens SIMATIC manager respectively
TIA Portal

* Integrated V-Bus controller for controlling System 200V peripherals
» Integrated 24V power supply

» Total address range: 1024Byte inputs, 1024Byte outputs

(128Byte process image each)
» 48...128kByte of work memory "on board"
» 80...192kByte of load memory "on board"

* MMC slot (for user program)
» Battery backed clock
« MP?l interface for data transfer

» Status LEDs for operating mode and diagnostics

CPU 214 $ CPU 214 $ CPU 215 $
RN g ] RN q = RN g
j@:y ! ja:]| ! jex
P ; W g W i
SF %] SF 3 SF ?‘j
. “p”z e “p”z re “p”z
| 7 | 7l | 7
g L g
© X % © x o9 © X %
SEwDDJw Efv+DDJ17 Efv"DDry
steay i) 2 M [D0]e teay il 2
VIPA 214-1BC06 VIPA 214-1BA06 VIPA 215-1BA06
Order data Type Order number Description
CPU 214C VIPA 214-1BC06 |PLC CPU 214 with
48/80kByte of work/load memory
CPU 214 VIPA 214-1BA06 |PLC CPU 214 with
96/144kByte of work/load memory
CPU 215 VIPA 215-1BA06 |PLC CPU 215 with
128/192kByte of work/load memory
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Chapter 2 Hardware description

Structure

Front view
CPU 21x

Interfaces
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Operating mode switch
LEDs of the CPU

Slot for MMC

memory card

MP? interface

Slot for DC 24V

power supply
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Manual VIPA System 200V

Power supply

MP?l interface

The CPU has an internal power supply. This is connected to an external
supply voltage via two terminals located on the front of the unit.

The power supply requires DC 24V (20.4 ... 28.8V). In addition to the
electronic circuitry of the CPU this supply voltage is used for the modules
connected to the backplane bus.

The electronic circuitry of the CPU is not dc-insulated from the supply
voltage. The power supply is protected against reverse polarity and short
circuits.

Note!
Please ensure that the polarity of the supply voltage is correct.

The MPI unit provides the link for the data transfer between the CPU and
the PC. Via bus communication you are able to exchange programs and
data between different CPUs that are linked over MPI.

For a serial exchange between the partners you normally need a special
MPI-converter. But now you are also able to use the VIPA "Green Cable"
(Order-No. VIPA 950-0KB00), which allows you to establish a serial peer-
to-peer connection over the MPI interface.

Please regard the "Hints for the deployment of the MPI interface" in chapter
"Deployment CPU 21x".

Memory The CPUs have an integrated work and a load memory. The memories are
Order number Work memory Load memory
VIPA 214-1BC06 48kByte 80kByte
VIPA 214-1BA06 96kByte 144kByte
VIPA 215-1BA0O6 128kByte 192kByte
In the load memory there are program code and blocks stored together with
the header information.
The program parts and blocks, which are relevant for the running program,
are loaded to the work memory during the program sequence.
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Operating mode
switch

RN
(®
MR

MMC slot
memory card

Battery backup for
clock and RAM

LEDs CPU

With the operating mode switch you may switch the CPU between STOP
and RUN.

During the transition from STOP to RUN the operating mode START-UP is
driven by the CPU.

By Switching to MR (Memory Reset) you request an overall reset with
following load from MMC, if a project there exists.

You may install a VIPA MMC memory card in this slot as external storage
device (Order No.: VIPA 953-0KX10).

The access to the MMC takes always place after an overall reset.

A rechargeable battery is installed on every CPU 21x to safeguard the
contents of the RAM when power is removed. This battery is also used to
buffer the internal clock.

The rechargeable battery is maintained by a charging circuit that receives
its power from the internal power supply and that maintain the clock and
RAM for a max. period of 30 days.

Attention!

Due to a long storage of the CPU, the battery may be discharged
excessively. Please connect the CPU at least for 24 hours to the power
supply, to achieve the full buffer capacity.

After a power reset and with an empty battery the CPU starts with a BAT
error and executes an overall reset, because with an empty battery the
RAM content is undefined.

The CPU has got LEDs on its front side. In the following the usage and the
according colors of the LEDs is described.

Name | Color |Description

PW | green |Indicates CPU power on.

R green | CPU status is RUN.

S yellow | CPU status is STOP.

SF red |lIs turned on if a system error is detected
(hardware defect)

FC | yellow [Is turned on when variables are forced (fixed).

MC | yellow | This LED blinks when the MMC is accessed.
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Manual VIPA System 200V

Technical Data

214-1BCO06 Order no. 214-1BCO06
Type CPU 214C
Technical data power supply
Power supply (rated value) DC 24V
Power supply (permitted range) DC 20.4...28.8 V
Reverse polarity protection v
Current consumption (no-load operation) -
Current consumption (rated value) 15A
Inrush current 65 A
12t 0.75 A%s
Max. current drain at backplane bus 3A
Power loss 3.5W
Load and working memory
Load memory, integrated 80 KB
Load memory, maximum -
Work memory, integrated 48 KB
Work memory, maximal -
Memory divided in 50% program / 50% data -
Memory card slot MMC-Card with max. 512 MB
Hardware configuration
Racks, max. 4
Modules per rack, max. total max. 32
Number of integrated DP master -
Number of DP master via CP 8
Operable function modules 32
Operable communication modules PtP 32
Operable communication modules LAN -
Status information, alarms, diagnostics
Status display yes
Interrupts no
Process alarm no
Diagnostic interrupt no
Command processing times
Bit instructions, min. 0.18 ps
Word instruction, min. 0.78 ps
Double integer arithmetic, min. -
Floating-point arithmetic, min. -
Timers/Counters and their retentive
characteristics
Number of S7 counters 256
Number of S7 times 256
Data range and retentive characteristic
Number of flags 8192 Bit
Number of data blocks 2047
Max. data blocks size 16 KB
Max. local data size per execution level 1024 Byte
Blocks
Number of OBs 14
Number of FBs 1024
Number of FCs 1024
Maximum nesting depth per priority class 7
Maximum nesting depth additional within an error | 1
OB
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Chapter 2 Hardware description

Order no. 214-1BC06
Time

Real-time clock buffered v

Clock buffered period (min.) 30d
Accuracy (max. deviation per day) 10s
Number of operating hours counter 8

Clock synchronization -
Synchronization via MPI -
Synchronization via Ethernet (NTP) -
Address areas (I/0O)

Input I/O address area 1024 Byte
Output I/O address area 1024 Byte
Input process image maximal 128 Byte
Output process image maximal 128 Byte
Digital inputs 8192
Digital outputs 8192
Digital inputs central 512
Digital outputs central 512
Integrated digital inputs -
Integrated digital outputs -

Analog inputs 512
Analog outputs 512
Analog inputs, central 128
Analog outputs, central 128
Integrated analog inputs -
Integrated analog outputs -
Communication functions

PG/OP channel v
Global data communication v
Number of GD circuits, max. 4

Size of GD packets, max. 22 Byte
S7 basic communication v

S7 basic communication, user data per job 76 Byte
S7 communication v

S7 communication as server v

S7 communication as client -

S7 communication, user data per job 160 Byte
Number of connections, max. 16
Functionality Sub-D interfaces

Type MP2|
Type of interface RS485
Connector Sub-D, 9-pin, female
Electrically isolated -

MPI v

MP2l (MPI/RS232) v

DP master -

DP slave -
Point-to-point interface -
Functionality MPI

Number of connections, max. 16
PG/OP channel v
Routing -

Global data communication v

S7 basic communication v

S7 communication v

S7 communication as server v

S7 communication as client -

HB97E - CPU - RE_21x-1Bx06 - Rev. 13/20
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Manual VIPA System 200V

Order no. 214-1BC06
Transmission speed, min. 19.2 kbit/s
Transmission speed, max. 187.5 kbit/s
Datasizes

Input bytes 0

Output bytes 0

Parameter bytes 3

Diagnostic bytes 0

Housing

Material PPE / PA 6.6
Mounting Profile rail 35 mm

Mechanical data

Dimensions (WxHxD) 25.4 x 76 x 80 mm
Weight 100 g
Environmental conditions

Operating temperature 0°Cto60°C

Storage temperature

-25°Cto 70 °C

Certifications

UL508 certification

in preparation

2-8
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214-1BA06

Order no. 214-1BA06
Type CPU 214
Technical data power supply

Power supply (rated value) DC 24V
Power supply (permitted range) DC 20.4...28.8 V
Reverse polarity protection v

Current consumption (no-load operation) -

Current consumption (rated value) 15A
Inrush current 65 A

12t 0.75 A%s
Max. current drain at backplane bus 3A

Power loss 35W
Load and working memory

Load memory, integrated 144 KB
Load memory, maximum -

Work memory, integrated 96 KB

Work memory, maximal

Memory divided in 50% program / 50% data

Memory card slot

MMC-Card with max. 512 MB

Hardware configuration

Racks, max.

4

Modules per rack, max.

total max. 32

Number of integrated DP master

Number of DP master via CP 8
Operable function modules 32
Operable communication modules PtP 32
Operable communication modules LAN -
Status information, alarms, diagnostics

Status display yes
Interrupts no
Process alarm no
Diagnostic interrupt no
Command processing times

Bit instructions, min. 0.18 ps
Word instruction, min. 0.78 ps
Double integer arithmetic, min. -
Floating-point arithmetic, min. -
Timers/Counters and their retentive

characteristics

Number of S7 counters 256
Number of S7 times 256
Data range and retentive characteristic

Number of flags 8192 Bit
Number of data blocks 2047
Max. data blocks size 16 KB
Max. local data size per execution level 1024 Byte
Blocks

Number of OBs 14
Number of FBs 1024
Number of FCs 1024
Maximum nesting depth per priority class 7
Maximum nesting depth additional within an 1

error OB

Time

Real-time clock buffered v
Clock buffered period (min.) 30d
Accuracy (max. deviation per day) 10s

HB97E - CPU - RE_21x-1Bx06 - Rev. 13/20
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Order no. 214-1BA06
Number of operating hours counter 8

Clock synchronization -
Synchronization via MPI -
Synchronization via Ethernet (NTP) -
Address areas (I/0O)

Input I/O address area 1024 Byte
Output I/O address area 1024 Byte
Input process image maximal 128 Byte
Output process image maximal 128 Byte
Digital inputs 8192
Digital outputs 8192
Digital inputs central 512
Digital outputs central 512
Integrated digital inputs -
Integrated digital outputs -

Analog inputs 512
Analog outputs 512
Analog inputs, central 128
Analog outputs, central 128
Integrated analog inputs -
Integrated analog outputs -
Communication functions

PG/OP channel v

Global data communication v
Number of GD circuits, max. 4

Size of GD packets, max. 22 Byte
S7 basic communication v

S7 basic communication, user data per job 76 Byte
S7 communication v

S7 communication as server v

S7 communication as client -

S7 communication, user data per job 160 Byte
Number of connections, max. 16
Functionality Sub-D interfaces

Type MP2]|
Type of interface RS485
Connector Sub-D, 9-pin, female
Electrically isolated -

MPI v

MP2| (MPI/RS232) v

DP master -

DP slave -
Point-to-point interface -
Functionality MPI

Number of connections, max. 16
PG/OP channel v

Routing -

Global data communication v

S7 basic communication v

S7 communication v

S7 communication as server v

S7 communication as client -
Transmission speed, min. 19.2 kbit/s
Transmission speed, max. 187.5 kbit/s
Datasizes

Input bytes 0

2-10
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Order no. 214-1BA06
Output bytes 0

Parameter bytes 3

Diagnostic bytes 0

Housing

Material PPE / PA 6.6
Mounting Profile rail 35 mm
Mechanical data

Dimensions (WxHxD) 25.4 x 76 x 80 mm
Weight 100 g
Environmental conditions

Operating temperature 0°Cto60°C
Storage temperature -25°Cto 70 °C
Certifications

UL508 certification in preparation

HB97E - CPU - RE_21x-1Bx06 - Rev. 13/20
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215-1BA06 Order no. 215-1BA06
Type CPU 215
Technical data power supply
Power supply (rated value) DC 24V
Power supply (permitted range) DC 20.4...28.8 V
Reverse polarity protection v
Current consumption (no-load operation) -
Current consumption (rated value) 15A
Inrush current 65 A
12t 0.75 A%s
Max. current drain at backplane bus 3A
Power loss 35W
Load and working memory
Load memory, integrated 192 KB
Load memory, maximum -
Work memory, integrated 128 KB
Work memory, maximal -
Memory divided in 50% program / 50% data -
Memory card slot MMC-Card with max. 512 MB
Hardware configuration
Racks, max. 4
Modules per rack, max. total max. 32
Number of integrated DP master -
Number of DP master via CP 8
Operable function modules 32
Operable communication modules PtP 32
Operable communication modules LAN -
Status information, alarms, diagnostics
Status display yes
Interrupts no
Process alarm no
Diagnostic interrupt no
Command processing times
Bit instructions, min. 0.18 ps
Word instruction, min. 0.78 ps
Double integer arithmetic, min. -
Floating-point arithmetic, min. -
Timers/Counters and their retentive
characteristics
Number of S7 counters 256
Number of S7 times 256
Data range and retentive characteristic
Number of flags 8192 Bit
Number of data blocks 2047
Max. data blocks size 16 KB
Max. local data size per execution level 1024 Byte
Blocks
Number of OBs 14
Number of FBs 1024
Number of FCs 1024
Maximum nesting depth per priority class 7
Maximum nesting depth additional within an error | 1
OB
Time
Real-time clock buffered v
Clock buffered period (min.) 30d
Accuracy (max. deviation per day) 10s
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Order no. 215-1BA06
Number of operating hours counter 8

Clock synchronization -
Synchronization via MPI -
Synchronization via Ethernet (NTP) -
Address areas (I/0O)

Input I/O address area 1024 Byte
Output I/O address area 1024 Byte
Input process image maximal 128 Byte
Output process image maximal 128 Byte
Digital inputs 8192
Digital outputs 8192
Digital inputs central 512
Digital outputs central 512
Integrated digital inputs -
Integrated digital outputs -

Analog inputs 512
Analog outputs 512
Analog inputs, central 128
Analog outputs, central 128
Integrated analog inputs -
Integrated analog outputs -
Communication functions

PG/OP channel v

Global data communication v
Number of GD circuits, max. 4

Size of GD packets, max. 22 Byte
S7 basic communication v

S7 basic communication, user data per job 76 Byte
S7 communication v

S7 communication as server v

S7 communication as client -

S7 communication, user data per job 160 Byte
Number of connections, max. 16
Functionality Sub-D interfaces

Type MP2]|
Type of interface RS485
Connector Sub-D, 9-pin, female
Electrically isolated -

MPI v

MP2| (MPI/RS232) v

DP master -

DP slave -
Point-to-point interface -
Functionality MPI

Number of connections, max. 16
PG/OP channel v

Routing -

Global data communication v

S7 basic communication v

S7 communication v

S7 communication as server v

S7 communication as client -
Transmission speed, min. 19.2 kbit/s
Transmission speed, max. 187.5 kbit/s
Datasizes

Input bytes 0

HB97E - CPU - RE_21x-1Bx06 - Rev. 13/20
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Order no. 215-1BA06
Output bytes 0

Parameter bytes 3

Diagnostic bytes 0

Housing

Material PPE / PA 6.6
Mounting Profile rail 35 mm
Mechanical data

Dimensions (WxHxD) 25.4 x 76 x 80 mm
Weight 100 g
Environmental conditions

Operating temperature 0°Cto60°C
Storage temperature -25°Cto 70 °C
Certifications

UL508 certification in preparation

2-14
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Chapter 3

Overview

Content

Deployment CPU 21x-1Bx06

This chapter describes the deployment of the CPU in the System 200V.
The description refers directly to the CPU and to the deployment in
connection with peripheral modules, mounted on a profile rail together with
the CPU at the backplane bus.
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Assembly

Note!

Information about assembly and cabling may be found at chapter "Basics
and Assembly".

Start-up behavior

Turn on power
supply

Boot procedure with
valid data in the
CPU

Boot procedure
with empty battery

When the CPU is delivered it has been reset. After the power supply has
been switched on, the CPU changes to the operating mode the operating
mode lever shows. After a STOP - RUN transition the CPU switches to
RUN without program.

Note!

Due to a long storage of the CPU, the battery may be discharged
excessively. Please connect the CPU at least for 24 hours to the power
supply, to achieve the full buffer capacity.

The CPU switches to RUN with the program stored in the battery buffered
RAM.

The accumulator/battery is automatically loaded via the integrated power
supply and guarantees a buffer for max. 30 days. If this time is exceeded,
the battery may be totally discharged. This means that the battery buffered
RAM is deleted.

In this state, the CPU executes an overall reset because with an empty
battery the RAM content is undefined. If a MMC with a STPROG.WLD is
plugged, program code and data blocks are transferred from the MMC into
the work memory of the CPU.

If there is no MMC, the project from the internal Flash is loaded.

Depending on the position of the operating mode switch, the CPU remains
in STOP respectively switches to RUN. Due to the battery error the CPU
can only boot if there was an OB81 configured. Otherwise a manual restart
(STOP/RUN) respectively PG command is necessary.

On a start-up with an empty battery the SF LED is on and thus points to an
entry in the diagnostic buffer. Information about the Event-IDs can be found
at "VIPA specific diagnostic entries".

Attention!

After a power reset and with an empty battery the CPU starts with a BAT
error and executes an overall reset.

3-2
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Addressing

Automatic
addressing

Signaling states in
the process image

Read/write access

To provide specific addressing of the installed peripheral modules, certain
addresses must be allocated in the CPU.

The CPU contains a peripheral area (addresses 0 ... 1023) and a process
image of the inputs and the outputs (for both each address 0 ... 127).

When the CPU is initialized it automatically assigns peripheral addresses to
the digital input/output modules starting from 0.

If there is no hardware projecting, analog modules are allocated to even
addresses starting from address 128.

The signaling states of the lower addresses (0 ... 127) are additionally
saved in a special memory area called the process image.

The process image is divided into two parts:
» process image of the inputs (PII)
» process image of the outputs (PIQ)

Peripheral area Process image
0 0
Digital modules | = - 'ngnts
127 127
128 0
~ | Analog modules Outputs
. _ PIQ
1023 127

The process image is updated automatically when a cycle has been
completed.

You may access the modules by means of read or write operations on the
peripheral bytes or on the process image.

Note!

Please remember that you may access different modules by means of read
and write operations on the same address.

The addressing ranges of digital and analog modules are different when
they are addressed automatically.

Digital modules: 0 ... 127
Analog modules: 128 ... 1023
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Example for auto- The following figure illustrates the automatic allocation of addresses:
matic address
allocation
Slot: 1 2 3 4 5 6
S 3| 3
S8z 8|8 8
& ) 8 Q a s} N
N [a] X ~ x X >
< o X © © <+
E @ - i o o o
O [a) [a) < o =) <
A
Pll rel. Addr. Peripheral area Peripheral area rel. Addr PlQ
0 Input byte 0 — t Output byte 0 0
1 Input byte 1 — Output byte 1 1
2 Input byte 2 Output byte 2 2
+“— 3 Input byte 3 <« Output byte 3 3 —>

127 | Input byte 127 Output byte 127 127

128 Input byte 0 ‘ T Output byte 0 128

digital

analog

analog digital
< —»

135 Input byte 7 4—‘ L Output byte 7 135
136 | Input byte 8 Output byte 8 136
137 | Input byte 9 Output byte 9 137

1023 | Input byte 1023 Output byte 1023 1023

Modifying allocated ~ You may change the allocated addresses at any time by means of the
addresses by Siemens SIMATIC manager. In this way you may also change the addres-
configuration ses of analog modules to the range covered by the process image

(0 ... 127) and address digital modules above 127.

The following pages describe the required preparations and the procedure
for this type of configuration.
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Hints for the deployment of the MPI interface

What is MP41?

Deployment as
MP interface

The MP?| jack combines 2 interfaces in 1:
* MP interface
» RS232 interface

Please regard that the RS232 functionality is only available by using the
Green Cable from VIPA.

The MP interface provides the data transfer between CPUs and PCs. In a
bus communication you may transfer programs and data between the
CPUs interconnected via MPI.

Connecting a common MPI cable, the MPI jack supports the full MPI
functionality.

Important notes for the deployment of MPI cables!

Deploying MPI cables at the CPUs from VIPA, you have to make sure that
Pin 1 is not connected. This may cause transfer problems and in some
cases damage the CPU!

Especially PROFIBUS cables from Siemens, like e.g. the
6XV1 830-1CH30, must not be deployed at MP?| jack.

For damages caused by nonobservance of these notes and at improper
deployment, VIPA does not take liability!

Deployment as
RS232 interface only
via "Green Cable"

For the serial data transfer from your PC, you normally need a MPI
transducer. Fortunately you may also use the "Green Cable" from VIPA.
You can order this under the order no. VIPA 950-0KB0O0.

The "Green Cable" supports a serial point-to-point connection for data
transfer via the MP?| jack exclusively for VIPA CPUs.
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SIMATIC Manager - Limitations

General Since the VIPA-CPU is configured as CPU 315-2AG10 in the Siemens
SIMATIC manager, there are limitations with the configuration of the VIPA-
CPU, which are in the following described.

Operating » OB 55 "Status interrupt" is not supported by the VIPA-CPU.
blocks - OBs « OB 56 "Update interrupt" is not supported by the VIPA-CPU.

» The phase shift, available for the OB 35 "Watchdog" in the Siemens
SIMATIC manager, is not evaluated by the VIPA-CPU.

Further limitations

"Plant designation" and "location identifier" in the Siemens SIMATIC
manager are not supported by the VIPA-CPU.

* In contrast to the Siemens CPU 315-2AG10 with a periphery address
area 0 to 2047, the periphery address area of the VIPA-CPU is limited to
0 to 1023.

» The bit memory (retentive memory) area is limited to 0 to 1023.
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Hardware configuration - CPU

Overview

Requirements

Including the
GSD-file

For the project engineering of the CPU 21x and the other System 200V
modules connected to the same VIPA bus, the hardware configurator from
Siemens is to be used.

To address the directly plugged peripheral modules, you have to assign a
special address in the CPU to every module.

The address allocation and the parameterization of the modules takes
place in the Siemens SIMATIC manager as a virtual PROFIBUS system.
For the PROFIBUS interface is standardized software sided, the
functionality is guaranteed by including a GSD-file into the Siemens
SIMATIC manager.

Transfer your project into the CPU via the MPI interface.

The following conditions must be fulfilled for project engineering:

» The Siemens SIMATIC manager is installed at PC respectively PU

» The GSD files have been included in Siemens hardware configurator
 Serial connection to the CPU (e.g. MPI-Adapter)

Note!

The configuration of the CPU requires a thorough knowledge of the
Siemens SIMATIC manager and the hardware configurator!

Go to www.vipa.com > Service > Download > PROFIBUS GSD files and
download the file System_100V_- 200V _Vxxx.zip.

e Extract the file to your work directory. The vipa 21x.gsd (German)
respectively vipa_21x.gse (English) can be found at the directory
CPU21x.

+ Start the Siemens hardware configurator and close every project.
» Go to Options > Install new GSD file

» Navigate to the directory CPU27x and choose the corresponding file
vipa_21x.gsd (German) or vipa_21x.gse (English)

Now the modules of the VIPA System 200V are integrated in the hardware

catalog at PROFIBUS-DP \ Additional field devices \ /O |\

VIPA_System_200V.
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To be compatible with the Siemens SIMATIC manager the following steps

Proceeding
should be executed:
Siot . Module PROFIBUS (1): DP master system (1)
2 CPU 315-2DP
X2 DP *
3
PB- (1) VIPA_CPU
Addr.:2 PB-
Addr.:1

Slot

Module

CPU 21x-1Bx06

Start the hardware configurator from
Siemens with a new project.

Insert a profile rail from the hardware
catalog.

Place at slot 2 the following CPU from
Siemens:

CPU 315-2DP (315-2AG10-0AB00
V2.6)

For the System 200V create a new
PROFIBUS subnet.

Attach the slave system
"VIPA_CPU21x" to the subnet with
PROFIBUS-Address 1.

After installing the vipa_21x.gsd the
slave system may be found at the
hardware catalog at PROFIBUS DP >
Additional field devices > IO >
VIPA_System_ 200V.

Place always at the 1. slot the
corresponding CPU 21x-1Bx06, by
taking it from the hardware catalog.
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Hardware configuration - /0 modules

Hardware After the hardware configuration of the CPU place the System 200V
configuration of modules in the plugged sequence.
the modules In order to address the installed peripheral modules individually, specific

addresses in the CPU have to be assigned to them.

S|10t Module
2 | CPU 315-2DP PROFIBUS (1): DP master system (1)

3
PB- (1) VIPA_CPU

Addr.:2 PB-
Addr.:1 | G202

111

>z
2 %N = Parameter DIO
N O 9| 5 m
O Q| Q|
(m) (q\] ~
9 °>é o>é = <>]_< Param : ......... Param : .........
[ce) Param: ........ Param: ......
—_ O 9 S @] Param: ......... Param: .........
CPU21x | O (@) (@] < < Slot Modu Param: ......... Param : .........
1 CPU
2 DI ’
4 DIO
) Al
6 AO
7
8
Parameterization For parameterization double-click during the project engineering at the slot

overview on the module you want to parameterize. In the appearing dialog
window you may set the wanted parameters.

Parameterization By using the SFCs 55, 56 and 57 you may alter and transfer parameters for
during runtime wanted modules during runtime.
For this you have to store the module specific parameters in so called
"record sets".

More detailed information about the structure of the record sets is to find in
the according module description.
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Setting CPU parameters

Parameterization
via Siemens
CPU 315-2AG10

Supported
parameters

General
Short description

Order No. /
Firmware

Name

Comment
Startup

Startup when
expected/actual
configuration differs

Since the CPU from VIPA is to be configured as Siemens CPU 315-2DP
(315-2AG10-0AB00 V2.6) in the Siemens hardware configurator, the
parameters of the VIPA CPU may be set with "Object properties" of the
CPU 315-2DP during hardware configuration.

Via a double-click on the CPU 315-2DP the parameter window of the CPU
may be accessed.

Using the registers you get access to every standard parameter of the
CPU.

Parameter CPU
Slot | Module Param: ......... Param: .........
1 Param : ......... Param : .........
2 CPU 315-2DP @ Param: ......... Param: .........
x2 [ ppP Param: ......... Param: .........
3
CPU

The CPU does not evaluate each parameter, which may be set at the
hardware configuration.

The following parameters are supported by the CPU at this time:

The short description of the Siemens CPU 315-2AG10 is CPU 315-2DP.

Order number and firmware are identical to the details in the "hardware
catalog" window.

The Name field provides the short description of the CPU. If you change
the name the new name appears in the Siemens SIMATIC manager.

In this field information about the module may be entered.

If the checkbox for "Startup when expected/actual configuration differ" is
deselected and at least one module is not located at its configured slot or if
another type of module is inserted there instead, then the CPU does not
switch to RUN mode and remains in STOP mode.

If the checkbox for "Startup when expected/actual configuration differ" is
selected, then the CPU starts even if there are modules not located in their
configured slots of if another type of module is inserted there instead, such
as during an initial system start-up.

3-10
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Monitoring time for
ready message by
modules [100ms]

Monitoring time for
transfer of
parameters to
modules [100ms]

Cycle/Clock
memory

Update OB1
process image
cyclically

Scan cycle
monitoring time

Minimum scan
cycle time

0B85 call up at I/0O
access error

Clock memory

This operation specifies the maximum time for the ready message of every
configured module after PowerON. Here connected PROFIBUS DP slaves
are also considered until they are parameterized. If the modules do not
send a ready message to the CPU by the time the monitoring time has
expired, the actual configuration becomes unequal to the preset
configuration.

The maximum time for the transfer of parameters to parameterizable
modules. If not every module has been assigned parameters by the time
this monitoring time has expired; the actual configuration becomes unequal
to the preset configuration.

This parameter is not relevant.

Here the scan cycle monitoring time in milliseconds may be set. If the scan
cycle time exceeds the scan cycle monitoring time, the CPU enters the
STOP mode. Possible reasons for exceeding the time are:

» Communication processes
» a series of interrupt events
» an error in the CPU program

This parameter is not relevant.

The preset reaction of the CPU may be changed to an I/O access error that
occurs during the update of the process image by the system.

The VIPA CPU is preset such that OB 85 is not called if an I/O access error
occurs and no entry is made in the diagnostic buffer either.

Activate the check box if you want to use clock memory and enter the
number of the memory byte.

Note!
The selected memory byte cannot be used for temporary data storage.
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Retentive Memory

Number of Memory
Bytes from MBO

Number of S7
Timers from TO

Number of S7
Counters from CO

Areas

Interrupts
Priority

Time-of-day

interrupts

Priority

Active

Execution

Start date / time

Process image
partition

Cyclic interrupts

Priority

Enter the number of retentive memory bytes from memory byte 0 onwards.
Retentive values > 1024 are not allowed.

Enter the number of retentive S7 timers from TO onwards. Each S7 timer
occupies 2bytes.

Enter the number of retentive S7 counter from CO onwards.

These parameters are not relevant.

Here the priorities are displayed, according to which the hardware interrupt
OBs are processed (hardware interrupt, time-delay interrupt, async. error
interrupts).

Here the priorities may be specified according to which the time-of-day
interrupt is processed.

With priority "0" the corresponding OB is deactivated.

Activate the check box of the time-of-day interrupt OBs if these are to be
automatically started on complete restart.

Select how often the interrupts are to be triggered. Intervals ranging from
every minute to yearly are available. The intervals apply to the settings
made for start date and time.

Enter date and time of the first execution of the time-of-day interrupt.

This parameter is not supported.

Here the priorities may be specified according to which the corresponding
cyclic interrupt is processed. With priority "0" the corresponding interrupt is
deactivated.
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Execution Enter the time intervals in ms, in which the watchdog interrupt OBs should
be processed. The start time for the clock is when the operating mode
switch is moved from STOP to RUN.

Process image This parameter is not supported.
partition

Protection

Level of protection Here 1 of 3 protection levels may be set to protect the CPU from
unauthorized access.

Protection level 1 (default setting):

* No password adjustable, no restrictions
Protection level 2 with password:

* Authorized users: read and write access

» Unauthorized user: read access only
Protection level 3:

» Authorized users: read and write access

* Unauthorized user: no read and write access
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Project transfer

Overview

Transfer via MPI

MPI programming
cable

Terminating resistor

There are the following possibilities for project transfer into the CPU:
» Transfer via MPI
» Transfer via MMC when using a MMC programmer

The structure of a MPI net is electrically identical with the structure of a
PROFIBUS net. This means the same rules are valid and you use the
same components for the build-up. The single participants are connected
with each other via bus interface plugs and PROFIBUS cables. Per default
the MPI net runs with 187.5kbaud. VIPA CPUs are delivered with MPI
address 2.

The MPI programming cables are available at VIPA in different variants.
The cables provide a RS232 res. USB plug for the PC and a bus enabled
RS485 plug for the CPU.

Due to the RS485 connection you may plug the MPI programming cables
directly to an already plugged plug on the RS485 jack. Every bus
participant identifies itself at the bus with an unique address, in the course
of the address 0 is reserved for programming devices.

A cable has to be terminated with its surge impedance. For this you switch
on the terminating resistor at the first and the last participant of a network or
a segment.

Please make sure that the participants with the activated terminating
resistors are always power supplied. Otherwise it may cause interferences
on the bus.

Transfer with MPI programming cable (MPl communication)

P T
[—

Terminating MPI net Terminating
Tl 1: B
gereas

MPI programming cable
{ |
Transfer via Green Cable (serial communication)

Via exclusively direct plugging of the Green Cable to a MP?l jack you may
establish a serial connection between PC and CPU. Set the PC-COM port
and the transfer rate 38400Baud at Local port. The settings of the register
MPI are ignored at employment of the Green Cable.

H}H

L

STEP7

from Siemens H |I ]
] ‘ °

|

Green Cable
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Configure MPI

Approach transfer
via MPI interface

Hints for configuring a MPI interface are to find in the documentation of
your programming software.

The "Green Cable" has the order number VIPA 950-0KB00.

Attention!

Please regard, that you may use the "Green Cable" exclusively at VIPA
CPUs with MP?I-interface!

Please regard the hints for deploying the Green Cable and the MP? jack!

Connect your PC to the MPI jack of your CPU via a MPI programming
cable.

Load your project in the SIMATIC manager from Siemens.
Choose in the menu Options > Set PG/PC interface

Select in the according list the "PC Adapter (MPI)"; if appropriate you
have to add it first, then click on [Properties].

Set in the register MPI the transfer parameters of your MPI net and type
a valid address.

Switch to the register Local connection

Set the COM port of the PC and the transfer rate 38400Baud for the MPI
programming cable from VIPA.

Via PLC > Load to module you may transfer your project via MPI to the
CPU and save it on a MMC via PLC > Copy RAM to ROM if one is
plugged.

Note!

Please make sure to adjust the transfer rate to 38400Baud when using the
"Green Cable" from VIPA.
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Hints for the
Green Cable

The Green Cable is a green connection cable, manufactured exclusively for
the deployment at VIPA System components.

The Green Cable is a programming and download cable for VIPA CPUs

MP?l jack and VIPA field bus masters. The Green Cable from VIPA is
available under the order no. VIPA 950-0KBO0O0.

The Green Cable allows you to:

 transfer projects serial
Avoiding high hardware needs (MPI transducer, etc.) you may realize a
serial point-to-point connection via the Green Cable and the MP? jack.
This allows you to connect components to your VIPA-CPU that are able
to communicate serial via a MPI adapter like e.g. a visualization system.

» execute firmware updates of the CPUs and field bus masters
Via the Green Cable and an upload application you may update the
firmware of all recent VIPA CPUs with MP?| jack and certain field bus
masters (see Note).

Important notes for the deployment of the Green Cable

Nonobservance of the following notes may cause damages on system
components.

For damages caused by nonobservance of the following notes and at
improper deployment, VIPA does not take liability!

Note to the application area

The Green Cable may exclusively deployed directly at the concerning jacks
of the VIPA components (in between plugs are not permitted). E.g. a MPI
cable has to be disconnected if you want to connect a Green Cable.

At this time, the following components support Green Cable:
VIPA CPUs with MP?l jack and field bus masters from VIPA.

Note to the lengthening

The lengthening of the Green Cable with another Green Cable res. The
combination with further MPI cables is not permitted and causes damages
of the connected components!

The Green Cable may only be lengthened with a 1:1 cable
(all 9 pins are connected 1:1).

3-16
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Transfer via
MMC

Transfer
MMC - CPU

Transfer
CPU - MMC

Transfer control

The MMC (Memory Card) serves as external transfer and storage medium.
There may be stored several projects and sub-directories on a MMC
storage module. Please regard that your current project is stored in the root
directory and has one of the following file names:

« S7PROG.WLD
» S7PROGF.WLD
« AUTOLOAD.WLD

With File > Memory Card File > New in the Siemens SIMATIC manager a
new wld file may be created. After the creation copy the blocks from the
project blocks folder and the System data into the wid file.

The transfer of the application program from the MMC into the CPU takes
place depending on the file name after an overall reset or PowerON.

e S7PROG.WLD is read from the MMC after overall reset and transferred
into the battery buffered RAM.

» S7PROGF.WLD is read from the MMC after overall reset and
transferred into the battery buffered RAM and additionally into the Flash
memory. An access to the Flash memory only takes place at empty
battery of the buffer and when no MMC with user program is plugged-in.

« AUTOLOAD.WLD is read after PowerON from the MMC and transferred
into the battery-buffered RAM .

During the transfer the "MC" LED blinks. Please regard that your user
memory serves for enough space, otherwise your user program is not
completely loaded and the SF LED gets on. Execute a compression before
the transfer, for this does not happen automatically.

When the MMC has been installed, the write command stores the content
of the battery buffered RAM as S7PROG.WLD on the MMC and in the
internal Flash memory.

The write command is controlled by means of the block area of the
Siemens SIMATIC manager PLC > Copy RAM to ROM. During the write
process the "MC"-LED of the CPU is blinking. When the LED expires the
write process is finished.

If this project is to be loaded automatically from the MMC with PowerON,
you have to rename this on the MMC to AUTOLOAD.WLD.

After a MMC access, an ID is written into the diagnostic buffer of the CPU.
To monitor the diagnosis entries, you select PLC > Module Information in
the Siemens SIMATIC manager. Via the register "Diagnostic Buffer" you
reach the diagnosis window.

Information about the Event-IDs can be found at "VIPA specific diagnostic
entries".
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Operating modes

Overview

Operating mode
STOP

Operating mode
START-UP

Operating mode
RUN

The CPU can be in one of 3 operating modes:
» Operating mode STOP

» Operating mode START-UP

» Operating mode RUN

Certain conditions in the operating modes START-UP and RUN require a
specific reaction from the system program. In this case the application
interface is often provided by a call to an organization block that was
included specifically for this event.

» The application program is not processed.

» If there has been a processing before, the values of counters, timers,
flags and the process image are retained during the transition to the
STOP mode.

» Outputs are inhibited, i.e. all digital outputs are disabled.
* RUN-LED (R) off
* STOP-LED (S) on

* During the transition from STOP to RUN the system calls the start-up
organization block OB 100. The processing time for this OB is not
monitored. The start-up OB may issue calls to other blocks.

» All digital outputs are disabled during the start-up, i.e. outputs are
inhibited.
* RUN-LED blinks as soon as the OB 100 is operated and for at least

3s, even if the start-up time is shorter or the CPU gets to
STOP due to an error. This indicates the start-up.

e« STOP-LED off

When the CPU has completed the start-up OB, it assumes the operating
mode RUN.

» The application program in OB 1 is processed in a cycle. Under the
control of alarms other program sections can be included in the cycle.

« All timers and counters being started by the program are active and the
process image is updated with every cycle.

» The BASP-signal (outputs inhibited) is deactivated, i.e. all digital outputs
are enabled.

* RUN-LED on
« STOP-LED off
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Function security

The CPUs include security mechanisms like a watchdog (100ms) and a

parameterizable cycle time surveillance (parameterizable min. 1ms) that
stop res. execute a RESET at the CPU in case of an error and set it into a

defined STOP state.

The VIPA CPUs are developed function secure and have the following

system properties:

Event concerns Effect
RUN - STOP |general BASP (Befehls-Ausgabe-Sperre, i.e. command
output lock) is set.
central digital outputs The outputs are disabled.
central analog outputs The Outputs are disabled.
- Voltage outputs issue 0V
- Current outputs 0...20mA issue OmA
- Current outputs 4...20mA issue 4mA
If configured also substitute values may be
issued.
decentral outputs Same behavior as the central digital/analog
outputs.
decentral inputs The inputs are cyclically be read by the decentra-
lized station and the recent values are put at
disposal.
STOP - RUN |general First the Pll is deleted, then OB 100 is called. After

res. PowerON

the execution of the OB, the BASP is reset and the
cycle starts with:
Delete PIO - Read PIl - OB 1.

central analog outputs

The behavior of the outputs at restart can be
preset.

decentral inputs

The inputs are cyclically be read by the decentra-
lized station and the recent values are put at
disposal.

RUN

general

The program execution happens cyclically and can
therefore be foreseen:
Read PIl -~ OB 1 - Write PIO.

Pll = Process image inputs
PI1O = Process image outputs

HBO7E - CPU - RE_21x-1Bx06 - Rev. 13/20
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Overall reset

Overview

Overall reset by
means of the
function selector

During the overall reset the entire user memory is erased. Data located in
the memory card is not affected.

You have 2 options to initiate an overall reset:
* initiate the overall reset by means of the function selector switch

* initiate the overall reset by means of the configuration software e.g.
Siemens SIMATIC manager

Note!

You should always issue an overall reset to your CPU before loading an
application program into your CPU to ensure that all blocks have been
cleared from the CPU.

Condition

The operating mode of the CPU is STOP. Place the function selector on the
CPU in position "ST" - the S-LED is on.

Overall reset

» Place the function selector in the position MR and hold it in this position
for app. 3 seconds. - The S-LED changes from blinking to permanently
on.

» Place the function selector in the position ST and switch it to MR and
quickly back to ST within a period of less than 3 seconds.
— The S-LED blinks (overall reset procedure).

« The overall reset has been completed when the S-LED is on
permanently. — The S-LED is on.

The following figure illustrates the above procedure:

@
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Automatic reload

Overall reset by
means of the
Siemens SIMATIC
manager

Automatic reload

Reset to factory
setting

If there is a project STPROG.WLD on the MMC, the CPU attempts to
reload this project from MMC - the MC LED is on.

When the reload has been completed the LED is extinguished. The
operating mode of the CPU will be STOP or RUN, depending on the
position of the function selector.

Condition

The operating mode of the CPU must be STOP.
You may place the CPU in STOP mode by the menu command
PLC > Operating mode.

Overall reset

You may request the overall reset by means of the menu command PLC >
Clean/Reset.

In the dialog window you may place your CPU in STOP mode and start the
overall reset if this has not been done as yet.

The S-LED blinks during the overall reset procedure.

When the S-LED is on permanently the overall reset procedure has been
completed.

At this point the CPU attempts to reload the parameters and the program
from the memory card. -~ The MC LED is on.

When the reload has been completed, the LED expires. The operating
mode of the CPU will be STOP or RUN, depending on the position of the
function selector.

A Factory reset deletes the internal RAM of the CPU completely and sets it
back to the delivery state.

Please regard that the MPI address is also set back to default 2!
More information may be found at the part "Factory reset" further below.
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Firmware update

Overview

Latest Firmware at
www.vipa.com

Find out CPU
firmware version

Load firmware and
transfer it to MMC
with reserved file
name

Reserved file
names

There is the opportunity to execute a firmware update for the CPU and its
components via MMC. For this an accordingly prepared MMC must be in
the CPU during the startup.

So a firmware files can be recognized and assigned with startup, a file
name is reserved for each updateable component (see table below).

After PowerON and CPU STOP the CPU checks if there is a firmware file
on the MMC. If this firmware version is different to the existing firmware
version, this is indicated by blinking of the LEDs and the firmware may be
installed by an update request.

The latest firmware versions are to be found in the service area at
www.vipa.com

A label on the rear of the module indicates the firmware version.

You may display the current firmware version of your CPU via the Siemens
SIMATIC manager. To display the firmware version, you go online with the
CPU via your PG or PC and start the Siemens SIMATIC manager.

Via PLC > Module status, register "General", the current firmware version is
evaluated and displayed.

* Go to www.vipa.com
» Click on Service > Download > Firmware.

» Navigate via System 200V > CPU to your CPU and download according
to your hardware version the zip file to your PC.

» Open the zip file and copy the bin file to your MMC.
» Rename this to firmware.bin.

By means of a reserved file name in the CPU 21x-1Bx06 you may transfer
a firmware per MMC:

Component File name New file name
order no._release_version.ZIP at MMC
CPU Bx000... .bin firmware.bin
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Attention!

When installing a new firmware you have to be extremely careful. Under
certain circumstances you may destroy the CPU, for example if the voltage
supply is interrupted during transfer or if the firmware file is defective.

In this case, please call the VIPA-Hotline!

Please regard that the version of the update firmware has to be different
from the existing firmware otherwise no update is executed.

Transfer firmware 1. Switch the operating mode switch of your CPU in position ST. Turn off

from MMC into the voltage supply. Plug the MMC with the firmware files into the CPU.

CPU Please take care of the correct plug-in direction of the MMC. Turn on
the voltage supply.

2. After a short boot-up time, the alternate blinking of the LEDs SF and FC
shows that at least a differing firmware file was found on the MMC.

3. You start the transfer of the firmware as soon as you tip the operating
mode switch lever downwards to MR within 10s and leave it in ST
position.

4. During the update process, the LEDs SF and FC are alternately blinking
and MC LED is on. This may last several minutes.

5. The update is successful finished when the LEDs PW, S, SF, FC and
MC are on. If they are blinking fast, an error occurred.

6. Turn Power OFF and ON. Now it is checked by the CPU, whether
further current firmware versions are available at the MMC. If so, again
the LEDs SF and FC flash after a short start-up period. Continue with
point 3.

If the LEDs do not flash, the firmware update is ready.

Now a factory reset should be executed (see next page). After that the
CPU is ready for duty.

ONENORENNO OEEENORNINO

Preparation Firmware Start update Update runs Update Error
recognized terminates
l RN at MMC error free
ST R R R R R R
. = = . s
MR =° S i —° —° AN
l N = va PW - RN - = va EPw =Pw - PV/V
- S Ip RN 4 — > L
MMC stecken /E!gr: N SF/ —sT /!ﬁ'i AN :SF/ !s’: Vs ‘\gi
Fc - JTFG d LA ;750: | |FC -1f¢  Power
] s N ] ] = s N
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Factory reset

Proceeding

)

CPU in
STOP

PW
SF

MC

With the following proceeding the internal RAM of the CPU is completely
deleted and the CPU is reset to delivery state.

Please note that here also the MPI address is reset to the address 2!

Switch the CPU to STOP.

Push the operating mode switch down to position MR for 30s. Here the
S LED flashes. After a few seconds the stop LED changes to static
light. Now the S LED changes between static light and flashing. Starting
here count the static light states of the S LED.

After the 6. static light release the operating mode switch and tip it
downwards to MR. Now the RUN LED lights up once. This means that
the RAM was deleted completely.

For the confirmation of the resetting procedure the LEDs PW and S are
on.

Then you have to switch the power supply off and on.

The proceeding is shown in the following lllustration:

2)

© ) s

Request factory reset Start factory reset Factory reset

@

executed

NI/

PW
SF
FC
MC

PW
SF

RN
ST

RN Tip RN
MR MR

30 Sec. | | 1 Sec.

FC Power

MR MC MC OFF/ON

[LITTEITTLTL ]
72
@
X
CILTTTEIT I IT]
»w T
m o=
CICTTTEIT ITTETT ]

Note!
After the firmware update you always should execute a Factory reset.
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VIPA specific diagnostic entries

Entries in the You may read the diagnostic buffer of the CPU via the Siemens SIMATIC
diagnostic buffer manager. Besides of the standard entries in the diagnostic buffer, the VIPA
CPUs support some additional specific entries in form of event-IDs.

Monitoring the To monitor the diagnostic entries you choose the option PLC > Module
diagnostic entries  Information in the Siemens SIMATIC manager. Via the register "Diagnostic
Buffer" you reach the diagnostic window:

[ Module information j

Path: Accessible Nodes MPI = 2 Operating mode CPU: RUN

Diagnostic Buff4r | ‘

Nr. Time ofday Date Event
10 13:18:11:370 19.12.2011 Event-ID: 16# EOCC K
1 ..

18 o - - VIPA-ID

Details:

The diagnosis is independent from the operating mode of the CPU. You
may store a max. of 100 diagnostic entries in the CPU.

The following page shows an overview of the VIPA specific Event-IDs.
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Overview of the
Event-IDs

Event-ID | Description

OxEO003 | Error at access to I/0O devices
Zinfo1: 1/O address
Zinfo2: Slot

O0xEO04 | Multiple parameterization of a I/0O address
Zinfo1: 1/0 address
Zinfo2: Slot

OxEO005 |Internal error — Please contact the VIPA-Hotline!

OxEQ006 |Internal error — Please contact the VIPA-Hotline!

0xEOQ7 | Configured in-/output bytes do not fit into I/O area

OxEO008 | Internal error — Please contact the VIPA-Hotline!

OxEO009 | Error at access to standard back plane bus

O0xEO10 | Not defined module group at backplane bus recognized
Zinfo2: Slot
Zinfo3: Type ID

OxEO011 |Master project engineering at Slave-CPU not possible or wrong slave configuration

O0xEO12 |Error at parameterization

0xEO013 |Error at shift register access to VBUS digital modules

OxEO014 |Error at Check_Sys

OxEO15 |Error at access to the master
Zinfo2: Slot of the master (32=page frame master)

OxE016 | Maximum block size at master transfer exceeded
Zinfo1: I/O address
Zinfo2: Slot

OxEO17 |Error at access to integrated slave

0xEOQ18 |Error at mapping of the master I/O devices

0xEO019 |Error at standard back plane bus system recognition

OxEO1A | Error at recognition of the operating mode (8 / 9 Bit)

OxEOCC | Communication error MPI / Serial

OxE100 | MMC access error

OxE101 [ MMC error file system

OxE102 | MMC error FAT

0xE104 | MMC error at saving

0xE200 |MMC writing finished (Copy Ram to Rom)

0xE210 |[MMC reading finished (reload after overall reset)

OxE300 |Internal Flash writing ready (Copy RAM to ROM)

0xE310 |[Internal Flash reading finished (reload after battery failure)
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Using test functions for control and monitoring of variables

Overview

Debug > Monitor

For troubleshooting purposes and to display the status of certain variables
you can access certain test functions via the menu item Debug of the
Siemens SIMATIC manager.

The status of the operands and the VKE can be displayed by means of the
test function Debug > Monitor.

You can modify and/or display the status of variables by means of the test
function PLC > Monitor/Modify Variables.

This test function displays the current status and the VKE of the different
operands while the program is being executed.

It is also possible to enter corrections to the program.

Note!
When using the test function “Monitor” the PLC must be in RUN mode!

The processing of the states may be interrupted by means of jump
commands or by timer and process-related alarms. At the breakpoint the
CPU stops collecting data for the status display and instead of the required
data it only provides the PG with data containing the value 0.

For this reason, jumps or time and process alarms can result in the value
displayed during program execution remaining at 0 for the items below:

+ the result of the logical operation VKE

» Status / AKKU 1

+ AKKU 2

» Condition byte

» absolute memory address SAZ. In this case SAZ is followed by a "?".

The interruption of the processing of statuses does not change the
execution of the program. It only shows that the data displayed is no longer.
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PLC >
Monitor/Modify
Variables

This test function returns the condition of a selected operand (inputs,
outputs, flags, data word, counters or timers) at the end of program-
execution.

This information is obtained from the process image of the selected
operands. During the "processing check" or in operating mode STOP the
periphery is read directly from the inputs. Otherwise only the process image
of the selected operands is displayed.

Control of outputs
It is possible to check the wiring and proper operation of output-modules.

You can set outputs to any desired status with or without a control program.
The process image is not modified but outputs are no longer inhibited.

Control of variables
The following variables may be modified:
,Q, M, T,CandD.

The process image of binary and digital operands is modified independently
of the operating mode of the CPU.

When the operating mode is RUN the program is executed with the
modified process variable. When the program continues they may,
however, be modified again without naotification.

Process variables are controlled asynchronously to the execution sequence
of the program.
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Chapter 4 Configuration with Siemens TIA Portal

Chapter 4

Overview

Content

Configuration with Siemens TIA Portal

In this chapter the project engineering of the VIPA CPU in the Siemens TIA
Portal is shown. The chapter only describes the basic usage of the
Siemens TIA Portal together with a VIPA CPU.

More detailed information about the Siemens TIA Portal is to be found in
the according online manual respectively documentation.

Theme Seite
Chapter 4  Configuration with Siemens TIA Portal ...........ccccceveeeeeee 41
TIA Portal - LImitations ..........ooooiiiiii e 4-2
TIA Portal - Work environment ..............ooeiviiiiiiiiiieeeeeeee 4-3
TIA Portal - Hardware Configuration - CPU ...........cccceiiiiiiiiiiieeeeen 4-5
TIA Portal - Hardware configuration - I/O modules ...........cccocciiieeeenn. 4-8
TIA Portal - Project transfer ... 4-9
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TIA Portal - Limitations

General

VIPA specific
SFCs

Operating
blocks - OBs

Further limitations

Since the VIPA-CPU is configured as CPU 315-2AG10 in the Siemens TIA
Portal, there are limitations with the configuration of the VIPA-CPU, which
are in the following described.

The VIPA specific SFCs are not supported during programming with the
Siemens TIA Portal.

» OB 55 "Status interrupt" is not supported by the VIPA-CPU
» OB 56 "Update interrupt" is not supported by the VIPA-CPU

« OB 81 "Error in power supply" exists in the VIPA-CPU but is not
supported by the Siemens TIA Portal

» The phase shift, available for the OB 35 "Watchdog" in the Siemens TIA
Portal, is not evaluated by the VIPA-CPU.

» "Plant designation" and "location identifier" in the Siemens TIA Portal are
not supported by the VIPA-CPU.

* In contrast to the Siemens CPU 315-2AG10 with a periphery address
area 0 to 2047, the periphery address area of the VIPA-CPU is limited to
0 to 1023. The diagnostic address area is 0 to 2047 and is not limited.

* The bit memory (retentive memory) area is limited to 0 to 1023.
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HB97E - CPU - RE_21x-1Bx06 - Rev. 13/20



Manual VIPA System 200V Chapter 4 Configuration with Siemens TIA Portal

TIA Portal - Work environment

General

Starting the
TIA Portal

Exiting the
TIA Portal

TIA is the abbreviation for Totally integrated Automation from Siemens.
Here your VIPA PLCs may be configured and linked. For diagnostics online
tools are available.

Note!

Information about the Siemens TIA Portal may be found in the online help
respectively in the according online documentation.

To start the Siemens TIA Portals with Windows select Start > Programs >
Siemens Automation > TIA ...

Then the TIA Portal opens with the last settings used.

TIA

Start Open existing project Existing Projects:
Create new project Project 1
Project 2
Project 3
Online &
Diagnostics

With the menu Project > Exit in the Project view you may exit the TIA
Portal.

Here there is the possibility to save changes of your project before.
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Work environment
of the TIA Portal

Portal view

Project view

Areas of the
Project view

Basically, the TIA Portal has the following 2 views. With the button on the
left below you can switch between these views:

The Portal view provides a "task oriented" view of the tools for processing
your project. Here you have direct access to the tools for a task. If
necessary, a change to the Project view takes place automatically for the
selected task.

The Project view is a "structured" view to all constituent parts of your
project.

The Project view is divided into the following areas:

TIA
Menu ...
*HE N e FREDRER 0 AR

—

| |

[1] Menu bar with toolbars

[2] Project tree with Details view

[3] Project area

[4] Device overview of the project respectively area for block
programming

[5] Properties dialog of a device (Parameter) respectively area for
information

[6] Hardware catalog and tools

[7] "Task-Cards" to select hardware catalog, tasks and libraries

[8] Jump to Portal or Project view

4-4
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TIA Portal - Hardware Configuration - CPU

General

Integration of the
GSD file

The hardware configuration of the CPU and the system 200V modules at
the VIPA bus takes place in the Siemens TIA Portal as a virtual PROFIBUS
systems.

For the PROFIBUS interface is standardized software sided, the
functionality is guaranteed by including a GSD-file into the Siemens TIA
Portal.

Your project can be transferred to the CPU via MPI interface or by means
of a MMC.

The GSD files may be found at www.vipa.com at the "Service" part.

The integration of the vipa 21x.GSD takes place with the following
proceeding:

* Browse to www.vipa.com.
» Click to Service > Download > PROFIBUS GSD files.
* Download the file System_100V_-_200V_Vxxx.zip starting with VV 2.2.2.

» Extract the file to your work directory. The vipa 21x.gsd (german)
respectively vipa_21x.gse (english) is stored in the directory CPU21x.

» Start the Siemens TIA Portal.

» Close every project.

» Switch to the Project view.

» Select Options > Install general station description file (GSD).

* Navigate to the directory CPU21x, select the according vipa_21x.gsd
(german) or vipa_21x.gse (english) and click at [Install].

The hardware catalog is refreshed and the Siemens TIA Portal is finished.

After restarting the Siemens TIA Portal all the System 200V CPUs and

modules of the System 200V from VIPA can now be found in the hardware
catalog at:

Other field devices > PROFIBUS DP > [/O > VIPA GmbH >
VIPA_System_200V.

Note!

Thus, the VIPA components can be displayed, you have to deactivate the
"Filter" of the hardware catalog.
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Proceeding

Parameterization

To be compatible with the Siemens TIA Portal the VIPA CPU is to be
configured as CPU 315-2DP (6ES7 315-2AG10-0AB0 V2.6) from Siemens.

The evolvement of the CPU 21x takes place as a virtual PROFIBUS master
system with the following proceeding:

» Start the Siemens TIA Portal.

» Create a new project in the Portal view with Create new project.
» Change to the Project view.

» Click in the Project tree at Add new device.

» Select the following CPU in the input dialog:
SIMATIC S7-300 > CPU 315-2DP > 6ES7 315-2AG10-0AB0 V2.6.
Then the CPU is inserted with a profile rail.

Project area:
1 2 4 5 6 7

|
0

Device overview:

Module ... |Slot ... |Type

PLC... 2 CPU 315-2DP
MPI interface... 20 MPI interface..
DP interface... 2 X2 DP interface...

Since the CPU from VIPA is configured as Siemens CPU, so the
parameterization takes place via the Siemens CPU.

For parameterization click in the Project area respectively in the Device
overview at the CPU part. Then the parameters of the CPU part are shown
in the Properties dialog. Here you can make your parameter settings.

Note!

The parameters are described in chapter "Deployment CPU..." at "CPU
parameterization".
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Configure a
PROFIBUS master
system

Connect and parameterize the internal DP interface at operation mode
"DP-Master".

Note!

Thus, the VIPA components can be displayed, you have to deactivate the
"Filter" of the hardware catalog.

Connect » Switch in the Project area to "Network view".
VIPA_CPU21x  Connect the slave system "VIPA_CPU 21x". After installing the
vipa_21x.GSD this may be found in the hardware catalog at:
Other field devices > PROFIBUS DP > /O > VIPA GmbH >
VIPA_System_200V > VIPA_CPU21x.
* For the slave system CPU21x-Slave-System set the PROFIBUS
address 1.

Network view

Catalog

i

(S]

PLC
CPU 315-2DP

Filter

Slave
VIPA_CPU21x

i

d

o~
(1
V 5 Other field devices

V¥V 5 PROFIBUS DP
VE o
V B3 VIPA GmbH

PROFIBUS

Slave

General

PROFIBUS- address
General DP param...

V [ VIPA_System_200V
FVIPA CP

[ VIPA CPU21x

[N Universal module

Properties
PROFIBUS address

interface networked with

Subnet:| PROFIBUS...

Parameters <§ )
Address:

Click at the slave system and open the "Device overview" in the Project
area.

Configure at slot 1 the according CPU 21x-1Bx06 of the hardware
catalog of the VIPA_System_200V.

Device overview:

Module Slot Type

Slave... 0 VIPA CPU21x

21x-1Bx06 1 21x-1Bx06...
2
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TIA Portal - Hardware configuration - I/O modules

Hardware
configuration of
the modules

VIPA_CPU21x l
0 w0
e/ N re.
Addr.:2 Addr.:1
> | 3 § .~
S 8 2 5 Q Parameter DIO
Q 0 2|« | <
(@] < gé — <
é g (@) ‘>1'< g Param: ......... Param: .........
cuze| 8 | ) BT < Slot | Mody param:-  param: -
0 Slave Param: ......... Param : ........
1 CPU
3 DCE/
4 DI
5 Al
6 AO
7

Parameterization

After the hardware configuration of the CPU place the System 200 modules
at the bus in the plugged sequence.

For this drag&drop the according module from the Hardware catalog to the
according position in the Device overview.

i

PLC
CPU 315-20P |©

Slave

CPU 21x

To provide specific addressing of the installed peripheral modules, certain
addresses must be allocated in the CPU.

For parameterization click in the Device overview on the module you want
to parameterize. The parameters of the module appear in the Properties
dialog.

Here you can make your parameter settings.
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TIA Portal - Project transfer

Overview

Transfer via MPI

Transfer via
MMC

There are the following possibilities for project transfer into the CPU:
» Transfer via MPI
» Transfer via MMC

Currently the VIPA programming cables for transfer via MPI are not
supported. This is only possible with the programming cable from Siemens.

» Establish a connection to the CPU with an appropriate programming
cable. Information may be found in the corresponding documentation of
the programming cable.

e Switch-ON the power supply of your CPU and start the Siemens TIA
Portal with your project.

» Select in the "Project tree" your CPU and choose from the context menu
Download to device > Hardware configuration to transfer the hardware
configuration. To transfer your PLC program choose Download to device
> Software. Due to the system you have to transfer hardware
configuration and PLC program separately.

The MMC (Memory Card) serves as external transfer and storage medium.
There may be stored several projects and sub-directories on a MMC
storage module. Please regard that your current project is stored in the root
directory and has one of the following file names:

« S7PROG.WLD
» S7PROGF.WLD
« AUTOLOAD.WLD

With Project > Memory card file > New a WLD file may be created in the
Siemens TIA Portal. Then the wld file is shown in the project tree at
"SIMATIC Card Reader" as "Memory card file".

Copy the blocks from the Programm blocks to the wid file. Here the
hardware configuration data are automatically copied to the wld file as
"System data".
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Transfer
MMC - CPU

Transfer
CPU - MMC

Transfer control

The transfer of the application program from the MMC into the CPU takes
place depending on the file name after an overall reset or PowerON.

« S7PROG.WLD is read from the MMC after overall reset and transferred
into the battery buffered RAM.

» S7PROGF.WLD is read from the MMC after overall reset and
transferred into the battery buffered RAM and additionally into the Flash
memory. An access to the Flash memory only takes place at empty
battery of the buffer and when no MMC with user program is plugged-in.

e AUTOLOAD.WLD is read after PowerON from the MMC and transferred
into the battery-buffered RAM .

The blinking of the LED "MC" of the CPU marks the active transfer. Please
regard that your user memory serves for enough space, otherwise your
user program is not completely loaded and the SF LED gets on.

When the MMC has been installed, the write command stores the content
of the battery buffered RAM as S7TPROG.WLD on the MMC and in the
internal Flash memory.

The write command is to be found in the Siemens TIA Portal in the Task
card "Online tools" in the command area at "Memory" as button [Copy RAM
to ROM]. Only if this function is supported by the CPU, this button is shown.

During the write process the "MC"-LED of the CPU is blinking. When the
LED expires the write process is finished.

If this project is to be loaded automatically from the MMC with PowerON,
you have to rename this on the MMC to AUTOLOAD.WLD.

After a MMC access, an ID is written into the diagnostic buffer of the CPU.
To monitor the diagnosis entries, you select Online & Diagnostics in the
Siemens TIA Portal. Via the register "Diagnostic Buffer" you reach the
diagnosis window.

Information about the Event-IDs can be found at "VIPA specific diagnostic
entries".
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